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Welcome to ZWCAD 2025 Official!

Dear friends,

We are glad to tell you that ZWCAD 2025 Official Beta is available now! Thanks to your
valuable feedback for the previous version, ZWCAD 2025 Official Beta how comes with

significant new feature and improvements. Now, let’s take a look at this version.

This Release Notes mainly introduce the new features and improvements in ZWCAD 2025
Official.

Yours sincerely,

The ZWSOFT Team

March 2024
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ZWCAD 2025 Release Notes

VERNUM= 25.00_2024.03.21(#11188-19a41d7704c)

1. Overview

ZWCAD 2025 primarily includes improvements in 5 aspects: 2D
functions, 3D functions, Interface, API, and Industry modules. The

specific details are as follows:

Note:
1. 32-bit version will be no longer supported from the 2025 version of ZWCAD,

R&D Center is committed to providing users with a more stable and efficient 64-bit
ZWCAD product.
2. Starting from the 2025 version, SP version will be no longer available and will be

replaced by Update Packages which will be released every 2-3 months.



NEW

Features&Enhancements

Description

2D Functionality Enhancement

PDF Import&Attach

Improvement

Improved efficiency in importing and attaching
PDF files.

Plot Improvement

Improved efficiency in plotting.

Text Display Improvement

Optimized display and editing accuracy for

Thai, Arabic, and Hebrew languages.

Associative Array

Improvement

Add “Tangent” branch command in array path,
meanwhile fixed issues related to abnormal data

in associative array creation and editing.

Revcloud Improvement

“Revcloud” has become the new CAD entity

type. Revcloud shapes can be edited quickly by
dragging grips.

FAS/VLX File Support

Compatible with AutoLISP files created with
Visual LISP. supports direct loading FAS/VLX

files.

3D Functionality Enhancement

Improvement of Efficiency

in Opening 3D Drawings

CPU capabilities were fully utilized to enhance

the efficiency of opening 3D drawings.

New Visualization Styles

It added “Conceptual”, “Realistic”, “Shade of
Grey”, and “X-ray” visual styles to provide
diverse visualization effects. The display
efficiency of 3D models has been enhanced for

a smoother viewing experience.
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STEP File Import

It supports the import of 3D files in STEP
format (AP203 and AP214 versions).

3D Gizmos

In the 3D visual style, objects can be
conveniently panned, rotated, scaled and

transformed through 3D gizmos.

New 3D workspace

Optimizations have been made to the
Workspace, significantly improving the ability

for users to customize their workspaces.

Interface and Interaction Optimization

Ribbon Redesign

A brand-new design of the ribbon, offering
features such as slide-out panels, dragging
panels, floating panels, and collapsed panels as
icons, to provide users with a highly

customizable interface.

Panel Redesign

Stacked and auto-hidden panels provide users
with a bigger drawing space. A new navigator
allows an easier interactive way of dragging and

docking panels.

Floating Documents

Window

Document windows can be dragged out of the
main program as floating windows, so users can
open one drawing on another monitor for

reference.

Help Document Redesign

It supports filtering in the offline help
document. It added online help documents
(Supported languages: including Simplified

Chinese, Traditional Chinese, English, Russian,




German, Spanish, French, Japanese, Korean).

It supports non-initial string matching, and

Command Matching sorting commands by frequency of use,

Improvement providing users with a more intelligent and

convenient interaction method.

Industry Application Improvement

It added 3 visual styles including

Point Cloud Module “Intensity”, ”Elevation”, and “Classification”

Improvement and support configuration to meet different

scenario needs.

It supports the import of commonly used map
sources such as Bing Maps, and the import of

GI1S Module Improvement | OGC standard map services. It also supports

(Function will released in setting markers in the map and setting insertion
Beta2 version) points in the drawing, so the map can the
drawing can be quickly matched according to

geographical location.

Convert raster images to vector data to meet
Raster to Vector

users' needs for converting paper drawings into

Conversion
DWG files.

API Improvement

For detailed information, please refer to the ZWCAD 2025 API Improvement.



https://www.dropbox.com/scl/fi/kxz02nz9zq73o0ptikdzz/ZWCAD-2025-API-Improvement-1.0.pdf?rlkey=6axxgylwwkchi1jc8n6880nd7&dl=1

2. New features and Improvement

2.1 2D Functionality Enhancement

2.1.1 PDF Import&Attach Improvement

The PDF file can be attached or imported into ZWCAD for use. In the
ZWCAD 2025, related functions for applying PDF files have been
optimized, including improved efficiency in panning and zooming
drawings containing PDF underlays, enhanced efficiency in importing
PDF files, and optimized results when importing text from PDF files.
® Improved efficiency in panning and zooming drawings containing

PDF underlays. The specific comparison data is as follows:

Panning Efficiency Comparison
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Figure 1. Comparison of panning with PDF underlay in drawings.
Conclusion: The panning efficiency in ZWCAD 2025 has improved
by 24 times compared to ZWCAD 2024, it is 3 times faster than the
competitor G2024, and equivalent to competitor A2024. The zooming



efficiency in ZWCAD 2025 has improved by 27 times compared to
ZWCAD 2024, it is 15 times faster than competitor G2024, and

equivalent to competitor A2024.

® Enhanced efficiency in importing PDF files, The specific comparison

data is as follows:

Zooming Efficiency Comparison
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Figure 2. Comparison of zooming with PDF underlay in drawings.
Conclusion: Based on the above test samples, the efficiency of
importing PDF files in ZWCAD 2025 has improved by 9 times
compared to ZWCAD 2024, it is 3 times faster than competitor

G2024, and 6 times faster than competitor A2024.
® Optimized results when importing text from PDF files.
2.1.2 Plot Improvement

ZWCAD 2025 has improved plotting efficiency and reduced the size of

printed PDF files in some scenarios with PDF and physical printers. It has



enhanced the intelligent printing's ability to recognize frame, supports
printing PDF files in some small languages, and fixed stability issues
related to PLOT functions.

® Improved printing efficiency for drawing includes image or underlay.

Output size for the same file

Semi-transparenet image Regular Raster Image Underlays

W AutoCAD 2024 GstarCAD 2024 ZWCAD 2024 ZWCAD 2025

Figure 3. Comparison of print file sizes among various CAD products.

® [mproved accuracy in smart plot frame recognition.
a) The accuracy of frame sequence recognition has been

improved, especially when there are significant differences in

frame sizes.

Figure 4. The recognition results on ZWCAD 2024
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Figure 5. The recognition results on ZWCAD 2025

b) Enhanced accuracy in identifying and comparing the reference

frame and graphics for clipping blocks.

Figure 6. The recognition results on ZWCAD 2025
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Figure 7. The recognition results on ZWCAD 2025

® Enhanced accuracy when printing Thai, Hebrew, Arabic, Sanskrit,

and Khmer languages using the DWG to PDF.pc5 printer.

2.1.3 Text Display Improvement

ZWCAD 2025 has optimized the display and editing accuracy for Thai,

Arabic, and Hebrew languages. It focuses on resolving issues such as

incorrect line breaks in Thai text display, incorrect display of

connected Arabic characters, and incorrect editing of text displayed

and read from right to left. It also addresses the problem of incorrect

character display order when mixing languages with different reading

directions (right to left and left to right).

Language

ZWCAD2024

Z\WCAD2025 Microsoft Office

Thal
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The MTEXT feature has been enhanced to include "Left-to-Right Text
Direction™ and "Right-to-Left Text Direction” functionalities, allowing
users with different language input directions to edit and read text

according to their accustomed text input sequence.
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Figure 8. Text Direction Setting

2.1.4 Associative Array Improvement

ZWCAD 2025 has fixed issues related to abnormal data in associative
array creation and editing. For drawings with associative array errors from
previous versions, a ZRX tool is provided for repair. To perform the
repair, load the "AuditArray.zrx" file as an attachment and execute the
AUDITARRAY command.

Additionally, this version introduces a new "Tangent" branch command in
path arrays. This branch ensures that cloned objects align with the tangent
direction on the path, maintaining consistency between the cloned object's
orientation and the path curve's tangent direction. This feature allows the
cloned object's orientation to always face the tangent direction of the path

curve.

2.1.5 Revcloud Improvement

Users often use revclouds for drawing review. Revcloud has become a
13



CAD object and command branches are expanded,

and editing of revclouds.

Revcloud as CAD Object Type

facilitating the creation

In the past, the CAD object type for revclouds was “polyline”. In this

version, it has been changed to "Revision Cloud." Users can directly edit

the shape of revclouds by dragging its grips and can modify the arc length

of revclouds through the properties panel.

Revision Cloud = [C ;72

T General

El Propertias

Handle
Color
Layer

Continu

0.00 mn

... ByLayer

Thickness  0.0000

Geometry
1

Figure 9. New CAD object called “Revision Cloud”
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>f Revision Cloud  + & ks

General -

Handle
Continus

0.00 mn

ByLayer

Specify the stretch ¢

Geometry
Vertex
407.4680

379.0048

E Properties

Figure 10. Users can change the shape of revcloud with grips

New Branch Commands

“Circle”, “Ellipse”, “Modify” commands are added so you can create
circular or elliptical revclouds. With the “Modify” command, you can edit
the shape of existing revclouds.

Ly BT RBRRETR ~- - @ 4} 2D Drafting & Annota.. * =
Home  Annotate Insert Views Tools Manage Export Online  Arc

NCGEGroiveCmAMaz

Line Polyline Circle Arc : Move Rotate Copy Mirror
- S = - - - & O

Iri - T ll -
Draw {::} Rectangular Modify
= Drawing1* Detailed Des ™ Tower-04* X

[—1 [Tep] [2D Wireframe]l [WCS] C} Polygonal

C;] Freehand
(O eliptical
O Circular

Figure 11. New revcloud types
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2.1.6 FAS/VLX File Support
It supports the direct loading of standard LISP binary files in FAS and

VLX formats. It improves LISP compatibility, eliminates format

conversion and enhances development efficiency.

ZWCAD Applications (*.zn¢;".Isp v

ZWCAD Applications (*.zrc;*.Isp;*.zel;*.zelx;*.vls;*.zvb)
Extension Application (*.zrx)

LISP Application (*.Isp)

LISP Encrypted Application (*.zel)

ZWCAD encry lisp execute file (*.zelx)

ZWCAD execute file (*.vis)

VBA Application (*.zvb)

Visual LISP executable file (*.vix)
Fast-load AutoLISP format (*.fas)

Figure 12. Directly load FAS/VLS applications

2.2 3D Functionality Enhancement

2.2.1 Improvement of Efficiency in Opening 3D Drawings

By fully utilizing CPU capabilities and leveraging multi-threading parallel
technology, we significantly enhanced the efficiency of opening 3D
drawings in ZWCAD.

2.2.2 New Visualization Styles

We added “Conceptual”, “Realistic”, “Shade of Grey”, and “X-ray” visual
styles and optimized the display quality of visual styles including

wireframe, hidden, shaded, and shaded with edges.
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Figure 13. New 3D visual styles

2.2.3 STEP File Import

STEP is an international file format in the mechanical industry. By
supporting STEP files import, the cost of file transfer from the design

department to manufacturers can be reduced.

Supported STEP Versions

It supports the import AP203 and AP214 versions of STEP files.
STEP Import Settings

It supports configuration of the import of STEP files, including destination

location, import method, and display settings.

17



STEP Import Settings x

Target drawing Display settings
() Cument drawing View: SW |sometric w
(®) New drawing Visual style: | Shaded w
Import method
(®) Import directly

() Specify insertion point

[ ] Always perform my cument choice Cancel Help

Figure 14. STEP Import Settings dialog

2.2.4 3D Gizmos

In the 3D visual style, objects can be efficiently and conveniently moved,
rotated and scaled. When the gizmo is selected, you can switch between

moving, rotating, and scaling by pressing the spacebar.

Figure 15. 3D gizmos help users edit 3D entities more easily.
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2.2.5 New 3D workspace

To redesign the ZWCAD workspace, create separate workspaces for 2D
drafting and 3D modeling, enabling users to focus on their commonly used

functions according to their requirements.
Add the ""'3D Modeling" workspace
Support switching the workspace in “Quick Access Toolbar” or “Status

Bar”, with the "2D Drafting & Annotation"” workspace launched by

default.

Menu

Ribbon

Toolbar
S EFRR BT R e« @ 1% 20 Drafting & Annotation v ¥ ZWCAD 2025 Professional Edition - [Drawing1.dwg]

2D Drafting & Annotation
Insert  Views Tools Annotate M 2D Drafting & Annotation

3D Modeling

) = 3D M = o
Y O v D 3D Modeling £ £ LayerMatch =
/‘ ZIS = Save Current As...
. 4 o~ - B Save Current As...

: £4 £ Make Current
Line Polyline Circle Arc Layer | Workspace Settings...

v i |12 Properties ® :

Customize...

Draw ~ Show Current Space Label

Drawing1® x 4+ F Ve ALY 3 E S

Figure 17. Ribbon setting for 3D workspace

Workspace Settings
a) Add the WSSETINGS command, which opens the "Workspace

Settings" dialog box when executed. In this dialog box, you can set the
current workspace, the display order of workspace menus, and whether

to save workspace modifications when switching workspaces.
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P Workspace Settings >

Current Workspace: | 30 Medeling e

Workspace Menu Display and Crder

®i|2D Drafting & Annotation Mawve Up
|30 Modeling

Add Separator

When Switching Workspace

() Do not save changes to workspace

@) Automatically save workspace changes

OK | | Cancel | | &Help

Figure 18. Workspace Settings Dialog

b) Add the WSSAVE command, which opens the "Save Workspace"

dialog box when executed. This feature allows you to quickly save the

current workspace.
FH save Workspace >
Name! | A-%01 Design| .

Figure 19. Dialog of saving workspace

¢) Add the WORKSPACE command, which is used to manage
workspaces. This includes setting the current workspace, saving,

editing, renaming workspaces, etc.
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nter a workspace option

* set Current

|

SAveas
Edit
Rename
Delete
alue <720 Draft notation”>: 30 Modeling SEttings

/Bdit/Rename/Delete/SE set Current’:

Figure 20. WORKSPACE Command

2.3 Interface and Interaction Optimization

2.3.1 Ribbon Redesign

The ribbon now includes new features such as slide-out panels, dragging
panels, and floating panels. Combined with CUI, it enhances the

customization level of interface.

Slide-out Panel

The panel can be expanded when you click on it and collapsed when you
move the mouse away from the slide-out area. You can also fix the panel

by clicking the “Pin” button on the left side to make it stay expanded or

collapsed.

yTETRBRRBET ~-

& Annotate Insert Views Tools

\ C. Y

Line Polyline Circle Arc

- - - - i:] -

5 Sketch % Wipeout O Donut

Region [ Super Hatch
- Draw =

Figure 21. Slide-out ribbon panel
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Dragging Panel

You can change the location of panels under the current tab on the Ribbon
by clicking on the panel (skipping function icons) and dragging it to the

desired location.

L E-RBRBRRBESR «- @ 1f2D Drafting & Annota... ¥ ¥ ZWCAD 2025 Trial versig

Annotat Ins Views Tools Manage Export Online ArcGIS APP+ [~ g

£¥ Layer Match N f reate [B] . Bylayer|
6 B

Make Current dit =
Insert Change _
Base Point = Define Attributes = ——————

Prop

Draw ~

Figure 22. Dragging ribbon panel
Floating Panel

You can drag the panel outside the Ribbon by clicking on the panel
(avoiding function icons) and dragging it to the desired location. The

floated panel can be grouped with others or collapsed.

‘m E
ale ] Fillet - M . i

4 ' EY St Cl Paste Copy and Paste
et mm Array - @ ex el g ine Attributes =2 r Ml - Settings

Clipbeard

Figure 23. Floating ribbon panel

2.3.2 Panel Redesign

Panels can be stacked and hidden automatically, including Properties
Panel, Layer Properties Manager, External Reference panel, Design

Centre, Tool Palette, Calculator, helping users expand the drawing area.
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Panel Stacking

When you drag one panel onto another, these panels can be stacked

together. Whether the panel is floated or docked, it can be combined with

Figure 24. panels stack together

Panel Auto-Hide
When the panel is docked on the side of ZWCAD, click the "Auto-Hide"

button in the top right corner of the panel, and the panel will be hidden.

You can choose to hide it as text or icon.
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1 E " RBRRMBEA -~ - @ 32D Drafting & Annota... ¥ ¥ ZWCAD 2025 Triz
Home Annotate it Views Tools Manage Export Online ArcGIS APP+

e g 2 & B’A ry ¥ Quality an '

[&] Display Image Frame ~
DWG _ XClip Edit Reference Attach Adjust Clip i g Insert Cre

Reference In-Place

Reference 4 Images

— Drawing1* X +

[—] [Top] [2D Wireframe] [WCS]
B

Hide as text Hide as icon

Figure 25. Different hiding methods

Navigator

When you drag the title bar of a panel, it will trigger the navigator between
the panel and the ZWCAD program. When you drag the panel to another
panel, it will trigger the navigator between them. The navigator can

provide you with a more intuitive preview effect.
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X Properties
= y
v ' & = No selection

General
Color ® Bylayer
0
Bylayer

Number Pad<{ 1
Bylayer
Transparency BylLayer
Thickness 0

View

M| € > |
Center Z QuickCalc
5 S v
Scientific<< - Height @ O B ™ | |4 [ X] | @

sin cos te 2
Width

asin | |acos| |at -
Misc
r2d d2r at = =
Annotation s... 1:1

Variables<{<

| Y ] e
= I Sample variak lcs per iew. | Yés Number Pad<<

k Phi C =

Visual style 2D Wireframe

7
4
1

ED Properties
= Palette Group

[E QuickCalc

Figure 26. Stacking Navigator

2.3.2 Floating Document Window

Document windows can be dragged out of the program, so users can open
one drawing on another monitor as a reference drawing. When opening
two or more drawings in ZWCAD, users can drag any document out of the

program by clicking on the document tab and dragging it to the desired

location.
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Figure 27. Drag a drawing out as a new window

2.3.4 Help Document Redesign

It added an online help document and optimized the search engine for the
offline help document so users can access the help documentation service

more conveniently.
New Online Help Document

Online help document enables users to access the help document anytime,
anywhere, on any device, without the need to open the program
(Supported languages: including Simplified Chinese, Traditional Chinese,

English, Russian, German, Spanish, French, Japanese, Korean).
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@ ZWCAD Help '3C‘C.$§3[—E|><
® engiish ~

Please enter the document keyword seardEEittEtl

English

= All Documents > ZWCAD Help > Express Tools > Draw > REVCLOUD Espafiol

All Documents =
uUD Frangais lI

ZWCAD 2024 [=E:3-2
=0
Modify ~
o Button: Pycckuii A3sik
e - Ribbon: Home » Draw » Rectangular, Polygonal, Freehand iy
i
BREAKLINE Toolbar: Draw » Revcloud
-
REVCLOUD Menu: Draw » Revision Cloud » Rectangular, Polygonal, Freehand
JOINL Keyboard: REVCLOUD
ANGDIV Create a revision cloud that is composed of multiple connected arcs.
ARCCMP Starting point
CON2DASH Specify the starting point of the revision cloud.
CHGLTSCA
Arc length
File Tools v . . . .
Specify the arc length. The maximum arc length and minimum arc length that you specified are saved in the
Tools ~ system registry, and considered as default values when the command is used next time.
Keyboard ~
Others - A NOTE The maximum arc length should be no greater than 3 times the minimum arc length.
ArcGIS ~
Installation and Registration ~ Object
Developer Help - Convert the selected closed object (circle, ellipse, polyline, spline, etc.) to a revision cloud.
After an object is selected, you are prompted to reverse the direction or not.
User Guide ~
Knowledge Document ~ Yes

. All other trademarks cited herein are the properties of their respective owners,

Figure 28. Online help document homepage

Offline Help Document Improvement

Offline help documentation supports filtering, enhancing the convenience

and efficiency of searching.
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ZWCAD 2025 Help

ESRI_CONTENTS

What's New

ArcGIS

Developer Help

User Guide

Knowledge Document

Configure Filtering Conditions:

Installation and Registration

Button:

Ribbon (2D): ArcGIS » Contents » Contents
Menu: ArcGIS » Contents

Keyboard: ESRI_CONTENTS

Open the GIS Contents palette.

In the GIS Contents palette, you can view and edit GIS |ayel in current CAD drawing.

AN

Add Data
Assign Coordinate System
Attribute Table Dialog Box

Attribute Viewer Dialog Box

Basic Vocabulary
ESRI_CONTENTS
ESRI_IMPORTSCHEMA

Edit Document Feature Layers

Edit Map and Image Layers

Edit Web Feature Layers
GIS Content

GIS Contents Palette

Contents. Index Favorites

© 1998-2023 ZWSOFT CO,, LTD.(Guangzhou). All rights reserved.

Figure 29. Search criteria help users more accuracy to find the content

2.3.5 Command Matching Improvement

The command matching mechanism has been improved to provide users

with a more intelligent command interaction experience.

Command Match Improvement

In the previous version, it had prefix matching only. In this version, it

added substring matching, wildcard matching and fuzzy matching. Users

can quickly locate the required commands by entering certain characters

or keywords of the command without having to enter the full name of the

command accurately.

LI (LIST]

a: 14

Wildcard Matching

Figure 30. Four Match Types
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Intelligent Sorting

When users input a string, the commands will be sorted by the frequency

of usage.
2.4 Industry Application Improvement

2.4.1 Point Cloud Module Improvement
New Visualization Styles

It added 3 new visualization styles including “Intensity”, “Elevation”, and

“Classification”. Also, users can configure point cloud colors.

Figure 31. Intensity visualization style

Figure 32. Elevation visualization style
29



Figure 33. Classification visualization style
Navigate to Scan View

In the Point Cloud Manager, right-clicking a subset will trigger a context
menu. Through the "Navigate to Scan View" function, and users can

quickly locate the corresponding view.

Figure 34. Navigate to the scan view to observe the interior of the building.

2.4.2 GIS Module Improvement

This module has replaced the original ArcGIS module to import maps and

represent geographic features in ZWCAD.

30



Map Service Import

It provides multiple map services including Bing Maps. Users can add

map services compliant with the OGC protocol.

Add Map

Select map

Q

Map Source | All ¥ | Map Name

Image Map - Bing Image Annotation Ma...

P .

Terrain Map - Tianditu

Vector Map Tianditu

i

TRk '“""*1
“. ~ e A LS

N A
Topographic Note - Ar... Terraln Map - Arcgis World Map - Arcqis

Basic Information

Name: Road Map - Bing
Service URL: https://dev.virtualearth.net/RESTA

Description: Global Road Map

Label: BING
Coordinate 3857
system:

Data range: Left: -20037508.34

Top: -20048966.1

Right: 20037508.34

Bottom: 20048966.1

OK I I Cancel | | Help

Figure 35. “Add Map” dialog box

Locating Function

You can match the geographic marker with the insertion point specified in

the drawing by specifying the latitude and longitude.

Figure 36. Visual representation of map and drawing matching
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2.4.3 Raster Image to DWG Conversion

It supports converting raster images into CAD entities, allowing users to
directly edit and modify the converted drawings. This feature helps users
reuse historic hand-drawn drawings or scanned drawings, reducing the

workload and cost of converting them to CAD drawings manually.

=
N

s ’ B 7 "\/
R AN ENE T VO

‘ Convert

Hand-drawn drawing DWG drawing
Figure 37. Convert raster image to DWG drawing
ZWCAD has made significant improvements to its APl modules,
including SDK upgrades, Ribbon API enhancements, .NET API
enhancements, and more. For detailed information, please refer to the
<ZWCAD 2025 API Improvement>.
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